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DISQUE MBR 

Les catégories de partition sur système INTEL: 

Un disque contient une table des partitions (MBR Master Boot Record). 

Les 446 premiers octets sont réservés au code du programme (ce code, lui 

dépend toutefois du système d'exploitation sous lequel la MBR a été créée). 

Les 64 octets suivants offrent la place nécessaire à une table de partition 

pouvant contenir jusqu'à quatre entrées.  

 

Chaque entrée dans la table des partitions peut correspondre soit à une 
partition primaire (dite aussi principale) soit à une partition étendue, (qui elle 

même peut contenir des partitions dites logiques) 

Les 3 catégories de partition primaires (ou principales), étendues et logiques 

sont des notions INDEPENDANTES de tout système d'exploitation. La notion est 

liée UNIQUEMENT à la plate-forme matérielle, à savoir INTEL (et compatibles) 

On peut répartir ces catégories de partitions en 2 groupes logiques :  

 Les partitions "conteneur" = qui sont essentiellement d'un seul type : 

o étendues (définissant une table de partition "hors  MBR" dans ce que 

l’on nomme une EBR)  

 Les partitions "contenus" = qui sont de deux types : 

o primaires (définies dans une table de partition dite MBR Master Boot 

record) au nombre de 4 maximum par disque physique 

o logiques (définies dans la EBR Extended Boot Record d’une partition 

étendue)  

Le problème (historique) est qu'au départ seulement 4 "rayonnages" au 

maximum ont été prévus. Toujours pour des questions historiques (au 

départ, les disques étaient tous petits, comparés à ceux de maintenant), 

on ne peut créer que un ou deux compartiments, le 2ème étant alors un 

nouveau tiroir, "emboîté" dans un compartiment. Et ce "petit" tiroir peut à 

nouveau contenir 2 compartiments, un pour du rangement (=partition 

LOGIQUE), et un autre pour un nouveau tiroir, et ainsi de suite, à l'infini 

(jusqu'à ce qu'il n'y ait plus de place du tout) 

 

Ce disque possède 1 partition PRIMAIRE (celle où on va stocker le système 

d'exploitation généralement), et 3 partitions LOGIQUES ( ici ce sont les seules 
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qui nous intéressent : les "contenus", les partitions ÉTENDUES n'étant que des 

"contenants") 

NB : Une table de partition (que ce soit celle du MBR ou celle d'une partition 

étendue) ne peut pas contenir plus de 4 entrées. 

N.B : Si vous créez des partitions principales multiples, seule une partition 

principale peut être active à la fois.  

N.B : La plupart des systèmes d'exploitation ne peuvent être amorcés qu'à 

partir d'une partition principale (qui peut contenir un secteur de boot)  

… …  

 

Structure d'un disque Windows Utilisant MBR 

Lorsque vous déployez Windows sur un appareil BIOS, vous devez formater 

les disques durs à l’aide d’un système de fichiers MBR. Windows ne prend 

pas en charge le système de fichiers GPT (GUID Partition Table) sur les 

ordinateurs BIOS. 

Un lecteur MBR peut contenir jusqu’à quatre partitions standard. 

Habituellement, ces partitions standard sont appelées partitions principales. 

 

 

Partition système 

Chaque lecteur de démarrage doit contenir une partition système qui doit 

être configurée en tant que partition active. 

La taille minimale de cette partition est de 100 Mo. 

 

Partition Windows 

Cette partition doit être d’au moins 20 gigaoctets (Go) d’espace pour les 

versions 64 bits ou d’au moins 16 Go pour les versions 32 bits. Cette partition 
doit être formatée au système de fichiers NTFS.  

Elle doit disposer d’un espace libre de 10 Go après que l’utilisateur a terminé 
la phase Out Of Box Experience (OOBE). Cette partition peut avoir au 

maximum 2 téraoctets (To) d’espace.  

N.B: Les outils logiciels permettant d’étendre l’espace de partitionnement 
accessible au-delà de 2 To ne sont pas pris en charge par le BIOS, car ils 

peuvent interférer avec des solutions logicielles liées à la récupération et à la 

compatibilité des applications 
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Partition des outils de récupération (optionnelle) 

L’image des outils Environnement de récupération Windows (Windows RE) 

(winre.wim) doit se trouver sur une partition distincte de celle de Windows 

pour prendre en charge le basculement automatique et le démarrage sur 

les partitions chiffrées avec éventuellement l’utilitaire de chiffrement de 

lecteur BitLocker de Windows. 

Cette image peut être incluse dans la même partition que la partition 

système. Cependant, nous vous recommandons de placer cette partition 

dans une partition distincte, immédiatement après la partition Windows.  

Cela permet à Windows de modifier et recréer la partition ultérieurement si 

des mises à jour futures nécessitent une plus grande image de récupération. 

Elle doit bénéficier d’un espace suffisant pour l’image des outils 

Environnement de récupération Windows (winre.wim, généralement 250 à 

300 Mo, selon la langue de base et les personnalisations ajoutées) et de 

suffisamment d’espace libre pour que la partition puisse être capturée par 

les utilitaires de sauvegarde : 

 Si la partition est inférieure à 500 Mo, elle doit avoir au moins 50 Mo 

d’espace libre.  

 Si la partition est supérieure ou égale à 500 Mo, elle doit avoir au 

moins 320 Mo d’espace libre.  

 Si la partition est supérieure à 1 Go, au moins 1 Go d’espace libre.  

Batch MBR 

A utiliser avec dispart pour créer 3 partitions avec une MBR 
select disk 0 
clean 
rem == 1. System partition ====================== 
create partition primary size=100 
format quick fs=ntfs label="System" 
assign letter="S" 
active 
rem == 2. Windows partition ===================== 
rem ==    a. Create the Windows partition ======= 
create partition primary 
rem ==    b. Create space for the recovery tools   
shrink minimum=500 
rem       ** NOTE: Update this size to match the 
rem                size of the recovery tools  
rem                (winre.wim)                 ** 
rem ==    c. Prepare the Windows partition ======  
format quick fs=ntfs label="Windows" 
assign letter="W" 
rem == 3. Recovery tools partition ============== 
create partition primary 
format quick fs=ntfs label="Recovery" 
assign letter="R" 
set id=27 
list volume 
exit 

.  
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DISQUE GPT 

Structure d'un disque Windows Utilisant GPT 

Pour déployer Windows sur un appareil UEFI, il faut formater le disque dur sur 

lequel se trouve la partition Windows en utilisant un système de fichier GPT 

(GUID Partition Table). Les lecteurs supplémentaires peuvent être au format 

GPT ou MBR (Master Boot Record).  

 

 

Partition système 

L’appareil doit contenir une partition système. Sur des disques GPT, il s’agit 

de la partition système EFI ou ESP (EFI System Partition). Cette partition est 

habituellement stockée sur le disque dur principal. C’est sur celle-ci que 

l’appareil démarre. 

Cette partition a une taille minimale de 100 Mo et doit être formatée selon le 
format de fichier FAT32. 

Cette partition est gérée par le système d’exploitation et ne doit pas 
contenir d’autres fichiers, y compris les outils Windows RE. 

 

Partition MSR (Microsoft® Reserved Partition) 

À partir de Windows 10, la taille de la partition MSR est de 16 Mo. 

Ajoutez une partition MSR sur chaque lecteur GPT pour faciliter la gestion 

des partitions. La MSR est une partition réservée qui ne reçoit pas d’ID de 

partition. Elle ne peut pas stocker de données d’utilisateurs. 

 

Partition Windows 

Cette partition doit être d’au moins 20 gigaoctets (Go) d’espace pour les 

versions 64 bits ou d’au moins 16 Go pour les versions 32 bits. La partition 

Windows doit être formatée au système de fichiers NTFS.  

Elle doit disposer d’un espace libre de 10 Go après que l’utilisateur a terminé 
la phase Out Of Box Experience (OOBE). 

 

Partition des outils de recuperation (optionnelle) 

Cette partition doit être d’au moins 300 Mo. 

Elle doit bénéficier d’un espace suffisant pour l’image des outils 

Environnement de récupération Windows (winre.wim, généralement 250 à 

300 Mo, selon la langue de base et les personnalisations ajoutées) et de 

suffisamment d’espace libre pour que la partition puisse être capturée par 

les utilitaires de sauvegarde : 

 Si la partition est inférieure à 500 Mo, au moins 50 Mo d’espace libre.  
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 Si la partition est supérieure ou égale à 500 Mo, au moins 320 Mo 

d’espace libre.  

 Si la partition a une taille supérieure à 1 Go, au moins 1 Go d’espace 

libre.  

Cette partition doit utiliser l’ID de type : DE94BBA4-06D1-4D40-A16A-

BFD50179D6AC.  

L’image des outils Environnement de récupération Windows (Windows RE) 

(winre.wim) doit se trouver sur une partition distincte de celle de Windows 

pour prendre en charge le basculement automatique et le démarrage sur 

les partitions chiffrées avec éventuellement l’utilitaire de chiffrement de 
lecteur BitLocker de Windows. 

Il est recommandé de placer cette partition immédiatement après la 

partition Windows. Cela permet à Windows de modifier et recréer la partition 

ultérieurement si des mises à jour futures le nécessitent 

Batch GPT 

A utiliser avec dispart pour créer 4 partitions avec une table GPT 
rem == CreatePartitions-UEFI.txt == 
rem == These commands are used with DiskPart to 
rem    create four partitions  for a UEFI/GPT-based PC. 
select disk 0 
clean 
convert gpt 
 
rem == 1. System partition ========================= 
create partition efi size=100 
rem    ** NOTE: For Advanced Format 4Kn drives, 
rem               change this value to size = 260 **  
format quick fs=fat32 label="System" 
assign letter="S" 
 
rem == 2. Microsoft Reserved (MSR) partition ======= 
create partition msr size=16 
 
rem == 3. Windows partition ======================== 
rem ==    a. Create the Windows partition ========== 
create partition primary  
rem ==    b. Create space for the recovery tools === 
shrink minimum=500 
rem       ** NOTE: Update this size to match the size of the recovery tools  
rem                (winre.wim)                    ** 
rem ==    c. Prepare the Windows partition =========  
format quick fs=ntfs label="Windows" 
assign letter="W" 
 
rem === 4. Recovery tools partition ================ 
create partition primary 
format quick fs=ntfs label="Recovery tools" 
assign letter="R" 
set id="de94bba4-06d1-4d40-a16a-bfd50179d6ac" 
gpt attributes=0x8000000000000001 
list volume 
exit  
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BIOS OU UEFI 

BIOS puis UEFI – historique : 

Le BIOS est le premier logiciel qui a été stocké dans la mémoire rom / flash des 

ordinateurs depuis les premiers PC de 1981 et qui permet de démarrer 

l'ordinateur.  

Aujourd'hui tous les PC ont un UEFI, mais il est courant de désigner UEFI 

comme étant un BIOS UEFI. (erreur de langage) 

 

Le BIOS ne sachant pas gérer GPT il est donc impossible d'avoir un disque dur 

de démarrage du PC > 2,2 To. 

Ce problème s'est posé en premier pour les serveurs avec des disques RAID. 

C'est pour cela que les serveurs ont été les premiers à proposer UEFI et GPTUEFI 

est le logiciel qui est stocké dans la mémoire flash des ordinateurs modernes 

qui permet de démarrer l'ordinateur. C'est lui qui initialise l'ordinateur, va 

vérifier que les composants fonctionnent correctement et va chercher le 

disque dur ou le CD-Rom pour démarrer un système d'exploitation. 

UEFI 2.0 date de 2006. Pour les PC grand public, les grands constructeurs ont 

attendu à ce que Microsoft le rende obligatoire en 2012, pour le programme 

de certification de Windows 8. La majorité des cartes mères proposaient 
l'UEFI en 2010 (mais par défaut, elles étaient configurées en mode BIOS-CMS) 

BIOS Fonctionnement: 

Le BIOS (Basic Input Output System) est le tout premier programme qui est 

exécuté lorsque vous allumez votre ordinateur. Le BIOS va charger tous les 

périphériques de base, effectuer un test du système – le POST (Power-On Self-

Test) – puis il exécute le code de démarrage du premier périphérique de votre 

liste de démarrage (Boot Priority). 

Si votre liste de démarrage commence par le disque dur où est installé 

Windows, le BIOS va alors exécuter le code de démarrage du disque dur : les 

446 octets réservés à l’intérieur de la MBR (Master Boot Record).  

 

A quoi ressemble un disque dur utilisant le MBR et sur lequel on installe 

Windows ? Le schéma ci-dessous vous donnera un aperçu minima de la 

structure du disque dur.  

Par défaut, le programme d’installation de Windows crée une partition 

système et une partition Windows.  
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UEFI Fonctionnement: 

L’UEFI (Unified Extensible Firmware Interface) est le remplaçant du BIOS. 

L’UEFI permet notamment: 

 La gestion des disques de plus de 2,2To 

 La prise en charge de fonctionnalités réseaux 

 La gestion des architectures 64bits 

 Un démarrage plus rapide de l’ordinateur 

L’UEFI permet de lire les tables de partition aussi bien que les fichiers 

systèmes contrairement au BIOS. Depuis la version 2.3.1, l'UEFI intègre une 

fonctionnalité Secure Boot n'autorisant le démarrage qu'aux systèmes 

d'exploitation reconnus. Cette fonctionnalité vise à interdire le démarrage 

d'un système d'exploitation corrompu notamment par un virus ou un rootkit. 

L’UEFI ne lance aucun code de démarrage, mais il lance des applications 

stockées dans une partition spéciale – présente dans la table de partitions – 
appelée « EFI SYSTEM PARTITION ». Parmi ces applications, on peut trouver 

un chargeur de système d’exploitation, un utilitaire de tests de mémoire ou 

bien des outils de restauration. 

Pour démarrer un système d’exploitation UEFI, le standard UEFI exige que 

votre disque dur utilise la table de partitionnement GPT (GUID Partition 

Table).  

N.B: L’UEFI peut aussi démarrer sur un disque dur utilisant la table de 

partitionnement MBR mais cette rétro-compatibilité implique de désactiver 

l’UEFI et d’émuler un BIOS traditionnel (via l’option CSM). Dès lors, vous ne 

bénéficiez plus des nouveaux avantages qu’offre l’UEFI. 

Lorsque vous installez la version UEFI de Windows, le programme d’installation 
de Windows crée donc 3 partitions,  une partition système EFI (Extensible 

Firmware Interface System Partition), une partition MSR (Microsoft Reserved 

Partition) et une partition Windows principale. 

 

EFI et MSR n’ont pas de lecteur logique associés 

MSR n’apparaît même pas dans les partitions présentes via l’interface 

 

Description 
ID de 

partition 
Taille 

Type de 

partition 
Format 

Lettre de 

lecteur 

Partition système EFI 1 100 Mo EFI FAT32 Aucune 

Partition MSR 
(Microsoft Reserved) 

2 128 Mo MSR Aucun Aucune 

Windows 3 
Reste du 
disque 

Principale NTFS C 

http://lecrabeinfo.net/disque-dur-les-tables-de-partitions-mbr-et-gpt.html#le-gpt-guid-partition-table
http://lecrabeinfo.net/wp-content/uploads/2013/03/partitions-disque-dur-uefi-699035.gif
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Activation CSM ou Legacy 

Le CSM (Compatibility Support Module) est un composant qui permet 

d’émuler un BIOS traditionnel, permettant ainsi d’installer des systèmes 

d’exploitation non compatibles UEFI. (Windows 32 bits). En activant cette 

option, l’UEFI sera désactivé. Il faut modifier le champ Boot Mode et mettre la 

valeur CSM Boot ou Legacy Boot. L’option peut consister à mettre le Boot 

UEFI sur Disabled. Par exemple on ira dans 

Bios Features / Boot Mode option / UEFI Only 

Ou conjointement sur les vieux bios 

Bios Features / Windows 8 features / Other OS 

 

Bios Features / CSM support / Always 
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Activation UEFI 

Sur un bios permettant les 2 modes, cela s’obtient en désactivant le CSM 
(Compatibility Support Module) qui est un composant qui permet d’émuler 

un BIOS traditionnel, Par exemple sur une CM on ira dans 

Bios Features / Boot Mode option / UEFI Only 

Ou conjointement sur les vieux bios 

Bios Features / Windows 8 features / Windows 8 

Bios Features / CSM support / Never 

A partir de là, pour booter, il faudra un HD partionné en GPT, et les 

périphériques de boot devront être choisit dans une liste UEFI uniquement 

 

Carte réseau – PXE 

Il faut demander d’activer la stack réseau UEFI par exemple dans 

Bios Features / Network stack / Enable 

Et (selon) 

Bios Features / IPV4 PXE support / Enable 

Bios Features / IPV6 PXE support / Enable 

 

Msinfo32.exe : savoir si on utilise un BIOS ou un UEFI 

en invite de commande rapidement cela donne  
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PARTITION MBR - GPT 

Table de partitionnement 

Une table de partitionnement est stockée sur un disque dur et contient les 

informations nécessaires pour diviser un disque dur en partitions. Il existe 

plusieurs modèles de table de partitionnement comme celle contenue dans 

le MBR (Master Boot Record) ou le GPT (GUID Partition Table). 

Depuis que le BIOS existe, nos disques durs utilisent la table de partitions MBR 

(Master Boot Record). L’UEFI, le remplaçant du BIOS, exige l’utilisation d’une 

nouvelle table de partitionnement : le GPT (GUID Partition Table). 

 

Partition MBR 

Le MBR (Master Boot Record) est le premier secteur d’un disque dur. 

Si la liste de démarrage de votre PC commence par un disque dur, le BIOS 

va donc exécuter le MBR (Master Boot Record) de ce disque dur. Le MBR 

contient la table de partitions et une routine d’amorçage permettant de 

charger le système d’exploitation ou le chargeur d’amorçage (bootloader). 

Le MBR est compatible avec tous les systèmes d’exploitation 32bits et 64 bits.  

Le MBR possède néanmoins des limitations : 

 4 partitions maximum de maxi 2,2 To (2 200Go) 

 Impossible de démarrer un disque dur MBR avec un système UEFI 
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Les limitations actuelles du MBR ont poussé les fabricants à se tourner vers 

une nouvelle table de partitionnement plus performante, introduite par Intel : 

le GPT. Le GPT est d’ailleurs le standard de l’UEFI, le remplaçant du BIOS. 

Partition GPT 

Le GPT (GUID Partition Table) est un nouveau standard pour décrire la table 

de partitionnement d’un disque dur,  

Le GPT fait partie du standard UEFI, c’est-à-dire qu’un système d’exploitation 

UEFI ne peut démarrer que sur un disque dur utilisant une table de partitions 

GPT. Un BIOS traditionnel ne peut démarrer sur un disque dur GPT. 

 

contrairement au MBR, le GPT ne contient pas de code d’amorçage. 

 

L’UEFI+GPT fonctionne différemment : l’UEFI charge directement le 

chargeur d’amorçage (bootloader) du système d’exploitation, enregistré 

sous la forme d’un fichier .efi sur la partition EFI du disque GPT.  

 Par exemple, Windows Boot Manager (le bootloader de Windows) est 

situé dans le répertoire \EFI\Microsoft\Boot sous le nom « bootmgfw.efi 

» 

 Un lecteur GPT peut comporter jusqu’à 128 partitions de maxi 256 To. 
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Disque MBR ou GPT … 

Dans les Outils d’administration / Gestion de l’ordinateur et Gestion des 

disques dans la colonne de gauche, Clic droit Propriétés sur le disque dur 

dont vous souhaitez connaitre la table de partitionnement. 

 

Dans l’onglet Volumes la valeur en face de Type de partition est marqué 

Table de partition GUID (GPT) ou Secteur de démarrage principal,  

 

 

http://lecrabeinfo.net/wp-content/uploads/2013/03/proprietes-disque-dur-gpt-volumes-aa5267.png
http://lecrabeinfo.net/wp-content/uploads/2013/03/proprietes-disque-dur-mbr-volumes-4f9599.png
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FAQ GPT - MBR 

Toutes les versions depuis Seven Windows 64 bits peuvent lire, écrire et booter 

sur un disque dur MBR 

Un système UEFI ne peut démarrer que sur un disque dur utilisant la table de 

partitions GPT. Une version UEFI de Windows reconnait parfaitement un 

disque dur MBR, vous pouvez modifier ou supprimer vos fichiers comme 

d’habitude. 

 

Quelle est le nombre limite de partitions sur un disque dur GPT ? 

128 partitions maximum sur Windows. 

Quelle est la taille limite d’une partition sur un disque dur GPT ? 

256 To par partition sur Windows. 

Quelles versions de Windows peuvent lire le contenu d’un disque dur GPT ? 

Toutes les versions 32 bits et 64 bits de Windows Vista, Windows 7, Windows 8 

et la version 64 bits de Windows XP. 

Peut-on avoir à la fois un disque dur MBR et GPT sur un même système ? 

Oui, vous devez pour cela posséder un Windows supportant le format GPT et 

démarrez votre ordinateur sur un disque dur GPT. 

Peut-on convertir un disque dur MBR en GPT et inversement ? 

Oui /Non, il faut que votre disque dur soit vide : il faut supprimer toutes les 

données et toutes les partitions de votre disque dur. Une exception avec un 

disque système MBR à convertir en GPT avec mbr2gpt 
 

Convertir un disque GPT en MBR – diskpart  

S'il faut convertir le disque dur GPT en MBR Cela entrainera la perte totale 

des données sur le disque 

Diskpart va nous permettre de convertir notre disque dur en MBR. 

 Listez les disques par : list disk. 

 Sélectionnez le disque dur que vous souhaitez convertir en MBR en 

tapant : select disk #  (# c'est le numéro de votre disque) 

 Saisissez la commande clean   

pour effacer toutes les partitions et toutes les données de votre disque 

dur. Votre disque dur sera vidé en laissant Espace non alloué. 

 Tapez ensuite convert mbr pour convertir votre disque dur en MBR. 

 Quittez diskpart en tapant exit 

Convertir un disque MBR système en GPT – mbr2gpt (10 – 1703) 

Il est possible de convertir une partition MBR en GPT sans réinstaller Windows. 

Depuis Windows 10 1703, l’utilitaire MBR2GPT 

peut convertir un disque sans perte de 

données. 
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Get-disk – liste des types de disques présents 

en powerschell rapidement cela donne  

 

pour des disques en MBR 

 

Mais aussi pour des disques en GPT 

 

 

BIOS UEFI +Partition GPT = VM de type 2 

Si on veut descendre une image avec un système de disque GPT, il faut que 

cela soit une VM de type 2 
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BOOT D’UN SYSTEME 

BIOS + MBR + programme amorçage  

Si la liste de démarrage de votre PC commence par un disque dur, le BIOS 

va donc exécuter le MBR (Master Boot Record) de ce disque dur. Le MBR 

contient la table de partitions et une routine d’amorçage permettant de 

charger le système d’exploitation ou le chargeur d’amorçage (bootloader). 

UEFI + partition Efi fichier + xxx.efi 

alors Windows Boot Manager (le bootloader de Windows) est situé dans le 

répertoire \EFI\Microsoft\Boot sous le nom « bootmgfw.efi 

Séquence de Boot 

Sur un PC et un BIOS standard ou EFI, la séquence d’amorçage sera 

Mise sous tension « Séquence POST » 

Si Bios lecture du programme d’amorçage ILL contenu dans la MBR 

permettant de savoir où se trouve le fichier Bootmgr 

Si UEFI, alors Windows Boot Manager (le bootloader de Windows) est 

situé dans le répertoire \EFI\Microsoft\Boot sous le nom « bootmgfw.efi » 

   Bootmgr 

   décode le magasin en \Boot\Bootstat.dat 

   Winload.exe    

   (crée l’environnement d’execution pour Windows11/10/7) 

   Détection hard HAL 

   (F8) 

   Appels drivers 

Multi-Boot 10-Seven (bootmgr) - XP (ntldr) : 

Sur un PC avec un BIOS ou EFI, la séquence d’amorçage Multi-Boot 10/7-XP 

Mise sous tension « Séquence POST » 

   Bootmgr 

 décode les entrées du magasin en \Boot\Bootstat.dat 

   si  win 10/7    si ancienne génération 

   Winload.exe     Ntldr  

   (crée l’environnement )   Boot.ini 

   (d’execution pour 11-10-SEVEN)  (choix lignes ARC) 

         Ntdetect.com 

   Détection hard    Détection hard 

   HAL      HAL 

   (F8)      F8+profils matériel 

  Appels drivers    Appels drivers 
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Ce qui au final, avec les outils de récupération 10/Seven et de diagnostic 

mémoire, pourrait donner le schéma suivant : 

 

 

Rappel Boot XP & ntldr: 

Depuis Windows NT, windows installe son secteur d'amorçage et quelques 

fichiers cachés sur la Partition Principale Active mais autorise l'installation de 

son répertoire \WINNT ailleurs. Le programme de Boot, identifie la partition 

active, charge le secteur de boot inscrit dans la MBR et lance le programme 

de boot qu'il contient. Ces programmes étaient :  

pour DOS :    IO.SYS et MSDOS.SYS (ou IBM....COM )  

pour Window 95/98 :  IO.SYS et MSDOS.SYS (fichier texte config)  

pour NT –2000 – XP :  NTLDR (="NT" Loader)  

Donc le secteur de boot de la MBR charge le programme NT Loader 

(NTLDR). Ce dernier affiche un menu de sélection basé sur le fichier de 

configuration BOOT.INI. La structure de ce fichier texte est relativement 

simple. Les fichiers suivants sont copiés dans le répertoire racine de la 

partition principale active :  

Boot.ini fichier de menu de lancement NT-2000 

Ntldr fichier systeme NT-2000 

Ntdetect.com fichier systeme NT-2000 

Bootfont.bin police systeme pour affichage écran 

Ntbootdd.sys si vous disposez d'un disque SCSI qui n'est pas visible à 

partir de MS-DOS (non détecté par le BIOS) 

Bootsect.dos (si un autre système d'exploitation se trouvait sur votre 

ordinateur, image du secteur de boot) 

10 - 2016 Xp - 2003 
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Ces fichiers ne doivent en aucun cas être supprimés, car ils sont 

indispensables au démarrage de NT. Ces fichiers sont tous des fichiers 
système cachés, en lecture seule. Après la séquence POST Power on Self 

Test, que tous PC déroule, indépendamment du système qui peut être 

installé. Le BIOS du PC vérifie la présence du matériels, (mémoire, disque, 

périphériques) le périphérique de démarrage est localisé dans la MBR, et 

charge alors le programme lanceur  

Sur une PC avec un BIOS, voici la séquence d’amorçage via Ntldr 

Mise sous tension « Séquence POST » 

   Ntldr 

   Boot.ini 

   (fichier texte de choix options) 

    Bootsect.dos (Si autre OS que NT) 

   Ntdetect.com 

     Détection du matériel 

   Ntoskrnel 

     HAL 

     F8 + profils matériels 

     Chargement drivers (/SOS ds boot.ini) 
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SECURE BOOT 

Notion de  Secure boot 

Depuis la version 2.3.1, l'UEFI intègre une fonctionnalité Secure Boot 

n'autorisant le démarrage qu'aux systèmes d'exploitation reconnus. Cette 

fonctionnalité vise à interdire le démarrage d'un système d'exploitation 

corrompu notamment par un virus ou un rootkit. 

En mode « lancement sécurisé » (secure boot), l'UEFI utilise un mécanisme 

de vérification par signatures numériques. Le micrologiciel interdit tout 

chargement de driver ou de noyau dont la signature ne correspondrait pas 

à celle gravée en ROM. 

 

Vérifiable dans les Paramètres, Mises à Jour et Sécurité, Sécurité Windows, 
Sécurité de l’appareil 

 

Activer Secure boot 

Les prérequis sont les suivants : 

 Bios UEFI activé (autrement dit CMS legacy désactivé) 

N.B : la la puce TPM n’est pas indispensable 

 

Secure boot étant une fonctionnalité particulière, il faut l’activer en 2 temps, 

car une fois activé (1° temp), il faut lui indiquer ou sont les éléments / clés 

qu’il doit utiliser pour sécuriser le démarrage (2°temps) 

Donc sur les vieux bios (pour être que ne mode UEFI, sans CMS) 

Bios Features / Windows 8 features / Windows 8 

Bios Features / CSM support / Never 

Puis on va dans  (1° temps) 

Bios Features / Secure boot state / enabled 

Et la on demande d’activer les defaults Security Key 
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Et là on demande  1 mode personnalisé avec les defaults Security Key  

Bios Features / Secure boot state / enabled 

Bios Features / Secure boot mode / Custom 

Bios Features / Key management/ manage all factory Keys 

 

Désactiver Secure boot 

Rendez-vous dans la configuration du BIOS UEFI en appuyant sur la touche 

Bios Features / Key management/ Clear Secure Boot Keys 
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T.P.M 

Objectif de TPM 1.2 ou 2.0 

Rendez-vous dans la configuration du BIOS UEFI en appuyant sur la touche 

appropriée lors du démarrage de l’ordinateur (souvent associée au terme 

BIOS Setup). Le Secure Boot, est une fonctionnalité dont le but est de bloquer 

tout élément étranger au système (comme un autre système d’exploitation). 

Chaque BIOS UEFI étant différent, il vous faut chercher le menu où se trouve 

cette option.  

Activer TPM 

Rendez-vous dans la configuration du BIOS UEFI en demandant  

 

Désactiver TPM 

Rendez-vous dans la configuration du BIOS UEFI en demandant 
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ANNEXE 1 – CONFIG DE PARTITIONS 
DEPLOIEMENT VIA WDS 

Objectif à atteindre 2 partitions MBR - BIOS 

1 partition principale Active de 79 Giga – NTFS – C : nommée os-systeme 

1 partition principale couvrant la fin du disque – NTFS - D : nommée data 

 

 

 

On demandera d’installer la selection sur la partition 1 

            <WindowsDeploymentServices> 

                <ImageSelection> 

                    <InstallTo> 

                        <DiskID>0</DiskID> 

                        <PartitionID>1</PartitionID> 

                    </InstallTo> 

                </ImageSelection> 

            </WindowsDeploymentServices> 

 

Fichier de réponse 

            <DiskConfiguration> 

                <Disk wcm:action="add"> 

                    <DiskID>0</DiskID> 

                    <WillWipeDisk>true</WillWipeDisk> 

                    <CreatePartitions> 

                        <CreatePartition wcm:action="add"> 

                            <Order>1</Order> 

                            <Size>79000</Size> 

                            <Type>Primary</Type> 

                        </CreatePartition> 

                        <CreatePartition wcm:action="add"> 

                            <Order>2</Order> 

                            <Extend>true</Extend> 

                            <Type>Primary</Type> 

                        </CreatePartition> 

                    </CreatePartitions> 

 

 

Suivit de 



  

Bios & UEFI – MBR & GPT 
Sr 10-11 – Sr22 – Cours - Ver 1.1 

https://www.cabare.net  
- Michel Cabaré  - 

Page 25/28 

 

                    <ModifyPartitions> 

                        <ModifyPartition wcm:action="add"> 

                            <Active>true</Active> 

                            <Format>NTFS</Format> 

                            <Label>os-systeme</Label> 

                            <Letter>C</Letter> 

                            <Order>1</Order> 

                            <PartitionID>1</PartitionID> 

                        </ModifyPartition> 

                        <ModifyPartition wcm:action="add"> 

                            <Letter>D</Letter> 

                            <Order>2</Order> 

                            <PartitionID>2</PartitionID> 

                            <Format>NTFS</Format> 

                            <Label>data</Label> 

                        </ModifyPartition> 

                    </ModifyPartitions> 

                </Disk> 

            </DiskConfiguration> 

        </component> 
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Objectif à atteindre 4-(5) partitions GPT - UEFI 

1 partition principale de 99 Mega – FAT32- EFI – sans lecteur -pour EFI / ESP 

1 partition non visible de 129 Mega – MSR (Microsoft System Reserved) 

1 partition principale Active de XXX Giga – NTFS – C : nommée os-systeme 

1 partition principale couvrant la fin du disque – NTFS - D : nommée data 

Et eventuellement 

(1 partition principale de 499 Mega – NTFS - outils réparation WinRe) 

 

 

 

 

 

Sur une installation a la main, avec partition pour WinRe 

 

 

On demandera d’installer la selection sur la partition 3 (ou 4 si WinRE) 

               <ImageSelection> 

                    <InstallTo> 

                        <DiskID>0</DiskID> 

                        <PartitionID>3</PartitionID> 

                    </InstallTo> 

                </ImageSelection> 
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Fichier de réponse 

              <DiskConfiguration> 

                <Disk wcm:action="add"> 

                    <CreatePartitions> 

                        <CreatePartition wcm:action="add"> 

                            <Order>1</Order> 

                            <Size>100</Size> 

                            <Type>EFI</Type> 

                        </CreatePartition> 

                        <CreatePartition wcm:action="add"> 

                            <Order>2</Order> 

                            <Size>128</Size> 

                            <Type>MSR</Type> 

                        </CreatePartition> 

                        <CreatePartition wcm:action="add"> 

                            <Order>3</Order> 

                            <Size>79000</Size> 

                            <Type>Primary</Type> 

                        </CreatePartition> 

                        <CreatePartition wcm:action="add"> 

                            <Order>4</Order> 

                            <Extend>true</Extend> 

                            <Type>Primary</Type> 

                        </CreatePartition> 

 

Suivit de 

 

                    </CreatePartitions> 

                    <DiskID>0</DiskID> 

                    <WillWipeDisk>true</WillWipeDisk> 

                    <ModifyPartitions> 

                        <ModifyPartition wcm:action="add"> 

                            <Format>FAT32</Format> 

                            <Label>system</Label> 

                            <Order>1</Order> 

                            <PartitionID>1</PartitionID> 

                        </ModifyPartition> 

                        <ModifyPartition wcm:action="add"> 

                            <Order>2</Order> 

                            <PartitionID>2</PartitionID> 

                        </ModifyPartition> 

                        <ModifyPartition wcm:action="add"> 

                            <Order>3</Order> 

                            <PartitionID>3</PartitionID> 

                            <Letter>C</Letter> 

                            <Label>os-syteme</Label> 

                            <Format>NTFS</Format> 

                        </ModifyPartition> 
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                       <ModifyPartition wcm:action="add"> 

                            <Order>4</Order> 

                            <PartitionID>4</PartitionID> 

                            <Letter>D</Letter> 

                            <Label>data</Label> 

                            <Format>NTFS</Format> 

                        </ModifyPartition> 

                    </ModifyPartitions> 

                </Disk> 

            </DiskConfiguration> 
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